
TÄRKEÄÄ TIETOA OHJELMISTOSTA
WinHestec on vanhemman sukupolven säätöohjelmisto, joka on suunniteltu 32-bittisille
Windows-käyttöjärjestelmille. Ohjelmistoa ei enää aktiivisesti kehitetä eikä se toimi
64-bittisissä Windows-versioissa.

WinHestecin käyttö edellyttää fyysistä RS232-sarjaporttia tai USB–RS232-adapteria.
USB–RS232-adapteria käytettäessä COM-portin asetuksen on oltava COM1. Muut
COM-portit eivät ole yhteensopivia WinHestec-ohjelmiston kanssa.

WinHestec-säätöohjelma on alun perin toimitettu sinisellä HASP-kopiosuojatikulla (USB),
jonka tuli olla kytkettynä tietokoneeseen ohjelman käytön aikana. Kyseisten
HASP-kopiosuojatikkujen myynti on sittemmin lopetettu.

Mikäli sinulla ei ole käytössä HASP-kopiosuojatikkua, ohjelman käyttö edellyttää
asiakaskohtaista lisenssiä. Lisenssin sekä WinHestec-ohjelman latauslinkin voi tilata
ottamalla yhteyttä:

Special Tuning Harinen Oy
info@hestec.fi
03-584 9777



WINHESTEC
KÄYTTÖOHJEET

TOIJALAN AUTOSÄHKÖ S.HARINEN KY
HELMUNTIE 83,37600 VALKEAKOSKI

PUH/FAX 03-5849777



SISÄLLYS

1. TIEDONSIIRTO..................................................................................................................................................................3

1.1 SÄÄTÖARVOJEN LUKEMINEN.........................................................................................................................................3
1.2 SÄÄTÖARVOJEN LÄHETTÄMINEN..........................................................................................................................................3

2. ANALOGIANÄYTTÖ.........................................................................................................................................................3

3. TIEDOSTO...........................................................................................................................................................................6

3.1 TIEDOSTON AVAAMINEN.....................................................................................................................................................6
3.2 SÄÄTÖARVOJEN TALLENTAMINEN........................................................................................................................................6

4. OPTIOT................................................................................................................................................................................7

4.1. KIERROSLUVUN RAJOITIN OPTIOT.......................................................................................................................9
4.2. LÄMPIMÄN MOOTTORIN KÄYNNISTÄMISEEN VAIKUTTAVAT OPTIOT......................................................9
4.3. KYLMÄRIKASTUS.......................................................................................................................................................9
4.4. KIIHDYTYSRIKASTUS.............................................................................................................................................10
4.5. TURVAOPTIOT...........................................................................................................................................................10
4.6. TYHJÄKÄYNNIN SÄÄTÖ.........................................................................................................................................11
4.7. AHTOPAINEEN SÄÄTÖ............................................................................................................................................11
4.8. VESIRUISKUN OHJAUS JA SUUTINLÄHTÖ 5......................................................................................................12
4.9 ANTILAG SYSTEM JA TEHONRAJOITUS..............................................................................................................12

5. SÄÄTÖKARTAT...............................................................................................................................................................15

MOTORCYCLE –ASENNOSSA SÄÄTÖKARTASTOLLA 15000RPM = MOOTTORIPYÖRÄKÄYTTÖ.............15

5. TIEDONKERUU................................................................................................................................................................18

6. LISÄKÄYRÄT...................................................................................................................................................................22

7. E- PROMMIN VAIHTO...................................................................................................................................................23

8. NÄPPÄIMET......................................................................................................................................................................24

TOIJALAN AUTOSÄHKÖ S.HARINEN KY
HELMUNTIE 83,37600 VALKEAKOSKI

PUH/FAX 03-5849777

2



TOIJALAN AUTOSÄHKÖ S.HARINEN KY
HELMUNTIE 83,37600 VALKEAKOSKI

PUH/FAX 03-5849777

3



1. TIEDONSIIRTO

Hestecin ohjelmaversio näkyy päävalikon alapalkissa kun ohjelmointikaapeli on kytketty tietokoneesta
Hesteciin, ohjelma käynnistetty ja Hestecissä on sähköt päällä. Jos yhteyttä ei ole, käyttäjä ei voi valita
tiedonsiirtotoimintoja. Jos yhteys ei muodostu, tarkista sarjaportin asetus päävalikosta (file -> settings 
-> serial port). 

HUOM  Kun lähetät tai luet säätöarvoja moottori ei saa olla käynnissä!
Poikkeuksena on tiedonkeruun luku, joka voidaan tehdä myös moottorin käydessä. Tiedonkeruu 
häviää Hestecin muistista, jos Hestecistä katkaistaan sähköt.

WinHestec 2004 –säätöohjelma vaatii toimiakseen vähintään v2.5W tai uudemman 
käyttöjärjestelmän.

Tiedonsiirtonopeuden valinta:

File -> settings -> serial port -> communication speed :

Normal –asennossa toimii perinteisen Hestec ohjainyksikön kanssa
Fast processor –asennossa toimii Hestec moottoripyörä ohjainyksikön kanssa (pieni yksikkö)

Huom!
Jos tiedonsiirtonopeus on väärässä asennossa, tiedonsiirto ei toimi oikein (ohjelmaversio ei näy 
alapalkissa oikein)!!!

1.1 Säätöarvojen lukeminen

Kun tiedonsiirtoyhteys on kunnossa, valitse päävalikosta Read from ECU.
vertaaminen
Jos tietokoneen muistiin on ladattu säätöarvot, voidaan niitä verrata ohjainyksikön säätöarvoihin 
lukuvaiheessa.

1.2 Säätöarvojen lähettäminen

Kun tiedonsiirtoyhteys on kunnossa, valitse päävalikosta Send to ECU. Voit lähettää kerralla kaikki 
arvot tai erikseen optiot, sytytys- ja seoskartat. Lisäkäyrät sisältyvät optioihin.
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2. ANALOGIANÄYTTÖ

Asetuksista voidaan valita, käytetäänkö analogiakanaville perusasetuksia vai käyttäjän määrittelemiä 
asetuksia (Kuva 2). Jos asetus on default- asennossa, ohjelma lukee muistista analogiakanavien 
määritykset. User- asennossa asetukset luetaan tiedostosta, johon voidaan muuttaa kanavien asetuksia. 
Optioiden kielen voi vaihtaa pääikkunasta File -> Settings -> Language. Valittavana on englanti ja 
suomi. 

Kuva2. Analogiakanavien asetukset

Valitsemalla Analogdisplay, saadaan näkyviin analogianäyttö. Kun yhteys on kunnossa, näkyy 
näytössä reaaliajassa kanavien tila. Jos yhteyttä ei ole, näkyvät kanavat tummempana.

Jos halutaan muuttaa kanavan asetuksia, valitaan kanava viemällä hiiri valintapisteen päälle, ja 
painetaan hiiren vasenta nappia. Analogiakanavien asetuksen täytyy tällöin olla user- asennossa. Kun 
kanava on valittu, valitaan ylävalikosta edit.

Kuva 3. Analogianäyttö
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Kuva 4. Analogiakanavan määritykset

Kanavalle voidaan antaa uudet määritykset (nimi, minimi, maksimi, desimaalien määrä ja yksikkö). 
Valikosta voidaan valita valmiiksi määriteltyjä kanavia. Uudet tiedot tallentuvat tiedostoon painamalla 
ok. Jos muutoksia ei haluta tallentaa, painetaan cancel. Määritykset tallentuvat WinHestec hakemiston 
tiedostoon hestec.dtg.
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3. TIEDOSTO

3.1 Tiedoston avaaminen

Valitse päävalikosta File ja Open. Näytölle avautuu uusi ikkuna. Tiedostokentässä näkyvät vain 
tiedostot, jotka kelpaavat Hestec ohjelmalle. Tiedosto valitaan hiiren vasenta nappia painamalla 
tiedoston nimen päällä. Tällöin nähdään tiedoston kommentit. Painamalla ok tai tuplaklikkaamalla 
tiedoston nimeä tiedosto avautuu. Cancel -napilla voidaan poistua tästä ikkunasta avaamatta tiedostoa. 

Kuva 5. Tiedoston avaaminen

Tiedoston poistaminen
Jos tiedosto halutaan poistaa, painetaan del näppäintä kun tiedosto on valittu. Ohjelma kysyy 
poistetaanko tiedosto.

Hakemiston poistaminen
valitse hakemisto ja paina Delete folder. Jos hakemistossa on tiedostoja, täytyy ne ensin poistaa.

3.2 Säätöarvojen tallentaminen

Valitse päävalikosta Save as. Tiedostolle voidaan kirjoittaa nimi File name- kenttään, tai 
vaihtoehtoisesti valita tiedostovalikosta hiirellä jo olemassa oleva nimi. Tiedostolle täytyy antaa 
kommentit, muuten tiedostoa ei voi tallentaa. Kun kommentit on kirjoitettu, ok -nappi tulee näkyviin. 

TOIJALAN AUTOSÄHKÖ S.HARINEN KY
HELMUNTIE 83,37600 VALKEAKOSKI

PUH/FAX 03-5849777

7



Tiedostoon tallentuu automaattisesti päivämäärä. Jos tiedosto on jo olemassa, ohjelma kysyy 
halutaanko tallentaa vanhan tiedoston päälle.

Autokohtaiset kansiot!!!
Make new folder- napilla voidaa luoda uusi kansio. Selkeyden vuoksi kannattaakin tallentaa tiedostot 
esimerkiksi autokohtaisiin kansioihin (ford, audi, bmw…).  Delete folder- napilla voidaan poistaa 
kansio. Jos hakemisto sisältää tiedostoja, täytyy ne poistaa ennen hakemiston poistamista.

Kuva 6. Autokohtaiset kansiot

4. OPTIOT

Optioista voidaan muuttaa Hestecin asetuksia. Kielen voi vaihtaa pääikkunasta File -> Settings -> 
Language. Valittavana on englanti ja suomi.

Kun ohjelman muistissa on säätöarvot (avattu tiedostosta tai luettu), voidaan optioita muuttaa 
valitsemalla edit values -> hestec options.
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Optiot on jaettu niiden käyttötarkoitusten mukaan.  Option voi valita aktiiviseksi painamalla hiiren 
vasenta nappia option nimen tai lukuarvon päällä. Kun optio on valittu voidaan arvoa muuttaa + tai – 
näppäimellä. 

Kuva 7. Optiot

Pikanäppäimet!!
Välilehden voi vaihtaa näppäimistöllä painamalla alt + välilehden numero samanaikaisesti (Esim alt ja 
1 samanaikaisesti). Painamalla option kirjainta, optio saadaan aktiiviseksi.
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Kaasunasennon kalibrointi  (vain vapaastihengittävä kaasunasentoohjattu)
Kaasunasentoanturi voidaan kalibroida kun paineanturi min- tai paineanturi max – option arvo on 
aktiivinen ja painetaan F5 näppäintä. Kun yhteys Hestec ohjainyksikköön on kunnossa, ohjelma hakee 
kaasunasennon arvot täydellä kaasulla ja kaasupoljin ylhäällä. 

4.1. KIERROSLUVUN RAJOITIN OPTIOT

Kierroslukurajoitin (optio 1.G)
Määritellään kierrosluku halutuksi.  Kierrosluvun ylitettyä tämän rajan sytytystä katkotaan.  
Jos kierrosluku nousee vielä yli 300 kierrosta katkeaa myös ruiskutus.
Jos käytössä on pelkkä ruiskutusversio, katkotaan ainoastaan ruiskutusta.  Tällöin rajoitus on 
300 rpm korkeampi kuin näytöllä oleva arvo.

Kierroslukurajoittimen toimintatapa  (optio 1.H)
Voidaan määritellä katkaiseeko kierrosluvun rajoitin sytytyksen.  Optio arvo 0-200 tai 
ruiskutuksen optioarvo 255-201

4.2. LÄMPIMÄN MOOTTORIN KÄYNNISTÄMISEEN VAIKUTTAVAT OPTIOT

Käynnistysruiskutusaika (optio 2.J)
Lämmintä moottoria käynnistettäessä lukee ainoastaan tämän ruiskutusajan ja suuttimen 
perusaukioloajan.

 
Käynnistysennakko (optio 3.B)

Käynnistysennakko startatessa.   Määritellään käynnistysennakko joka on voimassa kunnes 
saavutetaan alin sytytyskäyrän kierrosluku.

4.3. KYLMÄRIKASTUS

Kylmärikastuksen lämpöraja (optio 2.H)
Määrittelee moottorin lämpötilan minkä yläpuolella kylmäkäyntirikastus lakkaa 
vaikkuttamasta.  Tämän lämpötilan yläpuolella ei lisäkäyrissä oleva Cold enrichening -käyrä 
vaikuta. 
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Lisäkäyrissä olevalla kylmärikastuskäyrällä vaaka-akselilla on moottorin lämpötila ja 
pystyakselilla on ruiskutusaika.  Käyrältä voi säätää kylmäkäyntirikastuksen eri lämpötiloille.

Käynnistysrikastus (optio 2.G)
Käynnistysrikastus.  Määrittelee kuinka paljon kylmälle (alle 20o) moottorille annetaan 
startatessa lisärikastusta.

Kylmärikastuksen kesto (optio 2.I)
Määrittelee kuinka kauan käynnistysrikastus on käynnistyksen yhteydessä päällä.  HUOM jos 
kiihdytysrikastus aktivoituu, käynnistysrikastus kumoutuu.

4.4. KIIHDYTYSRIKASTUS

Kiihdytysrikastusmäärä (optio 2.C)
Määritellään bensamäärä kiihdytysrikastuksessa.  Kaikki suuttimet suihkuttavat yhtäaikaa kun
kiihdytysrikastus alkaa

Kiihdytysrikastusaika (optio 2.D)
Määritellään kiihdytysrikastuksen aika

Kaasukiihdytyksen herkkyys (optio 2.E)
Määritellään kuinka herkästi kiihdytysrikastus aktivoituu.  Mitä pienempi lukema, sen 
herkemmästä kaasun polkaisusta kiihdytysrikastus aktivoituu

4.5. TURVAOPTIOT

Pakokaasun lämpörikastus (optio 2.K)
Voidaan asettaa maksimi pakokaasun lämpötila, mitä ei haluta ylitettävän.  Jos lämpö 
saavuttaa tämän rajan, alkaa Hestec rikastamaan seosta kunnes lämpö putoaa alle asetetun 
lämpörajan.  Huomioi että suutin ajassa on varaa lisätä polttoainetta (vaatii K tyypin anturin 
0-1000 oC pakosarjaan 

Moottorinlämmön varoitusraja (optio 1.K)
Jos moottorin lämpö nousee yli tämän arvon, syttyy vaihtovalo ja palaa kunnes lämpö putoaa 
alle asetetun lämmön.  Ei muuta moottorin säätöarvoja.

Imuilman ennakkomyöhästys (optio 3.G)
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Vain turbo- versioissa. Muuttaa sytytysennakkoa myöhäisemmälle.  Jos tämä lämpöraja 
ylitetään, ennakko myöhästyy  1o per 4oC imuilman lämmössä. Kuitenkin enintään 5o 
myöhäisemmälle
Jos toiminto on suurempi kuin 50, voidaan toiminto testata ajoituslampulla ottamalla käynnin 
aikana imuilman lämpötunnistimen liitin irti.  Ennakko myöhästyy 5o

4.6. TYHJÄKÄYNNIN SÄÄTÖ

Katso analogiamittauksesta kaasun asennon lukema ja laita kaasupolkimen minimiasento (optio 1.F) 
tätä arvoa 1-2 numeroa suuremmaksi.
Laita syötönkatkaisu (optio 2.F)  noin 800 1/min tyhjäkäyntikierroslukua suuremmaksi.
PWM -lähdön taajuus (optio 4.A)  on yleensä arvossa 1 tai 2. Aseta haluttu tyhjäkäynti kierrosluku 
(optiolla 4.K).  Hae tyhjäkäyntiventtiili oletus optioon (optio 4.J)  sellainen lukuarvo, jolla lämmin 
moottori käy asetettua kierroslukua (asetettu optiolla 4.K).

Tyhjäkäyntiventtiili maksimi (optio 4.H)
Aseta sellainen lukuarvo millä kylmä moottori käy hyvin tyhjäkäyntiä.  Tämä optio nostaa 
tyhjäkäyntikierroslukua jos se putoaa alle asetetun.  Arvo on jonkin verran suurempi kuin 
Tyhjäkäynti kierrosluku asetus -option arvo (yleensä n. 10-20 lukuarvoa suurempi).  Arvo 
riippuu paljon tyhjäkäyntiventtiilistä.

Tyhjäkäyntiventtiili minimi (optio 4.I)
Tämä optio asetetaan muutama numero pienemmäksi kuin Tyhjäkäyntiventtiili asetus- optio.  
Jos tyhjäkäynti nousee yli asetetun, tämä optio korjaa sen alaspäin.

Tyhjäkäynnin säätö on hyvin yksilöllinen johtuen erilaisista moottoreista ja tyhjäkäynnin 
säätöventtiileistä.

4.7. AHTOPAINEEN SÄÄTÖ

Ahtopaineen säädön toimintasuunta (optio 4.G)
Asennossa 255 napa 16/15 on maadoitettuna  kunnes saavutetaan haluttu ahtopaine.  
Asennossa 0 napa maadoittuu vasta, kun saavutetaan haluttu ahtopaine.

Ahtopaine säädetään lisäkäyrällä (Turbopressure control curve)
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Voit säätää ahtopainetta moottorin eri kierrosluvulla.  Huom! näytössä oleva ahtopaine ei välttämättä 
ole maksimi ahtopaine mitä auto käyttää, mutta ahtopaineen säätö alkaa siitä paineesta mikä kullakin 
kierrosluvulla on määritelty.
Säädä perusahtopaine siten että täydellä säädöllä se on jonkin verran korkeampi kuin mitä tulet 
käyttämään.  Käyrästöllä se pudotetaan oikeaksi.

4.8. VESIRUISKUN OHJAUS JA SUUTINLÄHTÖ 5

Vesiruiskun paineraja (optio 4.B)
Vaatii prommin jossa pieni v esim V2.5Ftv
Ohjaus on maadoittava
Kun imuilman lämpö on yli 45 oC ja moottorin kierrosluku yli 3800 1/min ja ahtopaine yli Vesiruiskun
paineraja -optio arvon, kytkeytyy ohjaus päälle

Suutinlähtö 5 toimintatapa ja arvo (optiot 4.E ja 4.F)
Ei 5- sylinterisessä moottorissa. Suutinlähtö 5 :n lähtö on maadoittava. Tätä voidaan ohjata: moottorin 
kierrosluvusta, moottorin lämmöstä, imuilman lämmöstä, imu/ahtopaineohjaus, kaasun asennosta, 
pakokaasun lämmöstä.  Voidaan käyttää myös invertoituna.

4.9 ANTILAG SYSTEM JA TEHONRAJOITUS

ANTILAG SYSTEM (”Paukkujärjestelmä”)
(Toimii vain 4 -sylinterisissä ja vaatii prommin jossa turbo käyttöjärjestelmä.)

Antilag –järjestelmälle asennetaan katkaisija jolla maadoitetaan Hestecin tiedonkeruunapissa olevan 
vihreä johdin kun toiminto aktivoidaan. Jos käytetään tapaa 1, katkaisijalla maadoitetaan myös 
ohitusventtiili.

- Säätömoodi (optio 1.N) asetetaan asentoon 4 (Antilag + alempi rpm raj.).

- Kun moottori ei käy, mene analogiamittauksiin (Analog display).  Katso kaasunasento lukuarvo, ja 
muuta Kaasupolkimen minimiasento (optio 1.F) noin 2-3 numeroa tätä suuremmaksi.

- Rpm raja Antilag- moodissa (optio 4.D)
Optiolla määritetään kierroslukuraja jonka yläpuolella katkotaan sytytystä epäsäännöllisesti 
kun kaasuläppä suljetaan. 
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- Antilag aktivointi kaasunasento  (optio 4.C)
Paukku aktivoituu tämän kaasunasennon alapuolella kun kaasupoljin nostetaan nopeasti ylös.

- Lisäkäyrissä on kaksi käyrää (Antilag ignition  ja Antilag enrichening ). Ensimmäisellä säädetään
sytytysennakon myöhästys eri kierrosluvuille ja jälkimmäisellä polttoainemäärää eri kierrosluvuille  
(lisärikastus). kun Antilag on aktivoitunut. 

On kaksi tapaa toteuttaa “paukkujärjestelmä”:

Tapa 1) Asennetaan sähköinen kaasuläpän ohitusventtiili (halkaisija yleensä n. 20mm). Kun 
Antilag- katkaisija on päällä, maadoittaa se samalla ohitusventtiilin.  Venttiili avaa 
kaasuläpän ohituskananavan. 

Antilag tk- kaasunasento (optio 3.F)
Tämä optio täytyy asettaa pienemmäksi kuin kaasunasennon arvo 
analogiamittauksessa.

Kun Antilag –katkaisija on  päällä tyhjäkäynti säädetään sopivaksi Antilag ignition- 
lisäkäyrällä (ei kaasuläpästä). 

Tapa 2) Antilagin toimivuuden vuoksi kaasuläppä säädetään tavallista enemmän auki 
tyhjäkäynnillä. Ruiskutuskatkonnalla rajoitetaan tyhjäkäyntikierroslukua. Tämän vuoksi 
säätömoodi (optio 1.N) pidetään asennossa 4 (normaalisti moottori kävisi tyhjäkäyntiä n. 
4000-6000rpm).

Antilag tk- kaasunasento (optio 3.F)
Kun kaasuläppä on suljettuna aseta tämä optio  5-10 numeroa 
analogiamittauksesta katsottua kaasunasentoa suuremmaksi. Kun 
kaasunasento ylittää tämän lukuarvon, tulee kaikki ruiskutukset mukaan.  

Säädä seuraavaksi tyhjäkäynti siten että moottori käy noin 2000 1/min. HUOM! Jos 
tyhjäkäyntiä joudutaan säätämään kaasuläpästä suuremmalle huomioi optiot 1.F ja 3.F 
säätöohjeet! 
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TEHONRAJOITUS
(vaatii special- käyttöjärjestelmän, ei käytössä turbo versiossa)

Tehonrajoitus aktivoituu, kun Hestec napa 20/9 maadoitetaan katkaisijalla. 

Kierrosten maksimi nousunopeus määritetään optiolla (optio 3.D)
Asennossa 1 kun kierrokset nousevat yli 915 rpm/s

2 kun kierrokset nousevat yli 1830 rpm/s
3 kun kierrokset nousevat yli 2475 rpm/s
4 kun kierrokset nousevat yli 3650 rpm/s
5 kun kierrokset nousevat yli 4575 rpm/s

Kun tehonrajoitus aktivoituu, muutetaan sytytysennakkoa option 3.E arvon verran (±25o).

4.10 SYTYTYKSEN PERUSENNAKON KALIBROINTI

Sytytyksen siirto (optio 3.C) voidaan sytytysennakkoa kalibroida myöhäisemmälle, jos trigger- pulssit 
tulevat liian aikaisin.

Tärkeä toimenpide Hestecin käyttöönotossa tai käyttöjärjestelmän(E-PROM)
päivityksen jälkeen!!!

SYTYTYSENNAKON TARKISTUS:
Muuta sytytysennakkokäyrät 0o kierrosluvulta 3000-5000rpm. Lähetä arvot Hesteciin. Käynnistä 
moottori ja nosta kierrosluku siten, että analogiamittauksissa (Analog display) näkyy 0o 
sytytysennakko. Tarkista samanaikaisesti ajoituslampulla kampiakselilta todellinen sytytysennakko. 
Jos sytytys on aikaisella, myöhäistä ennakkoa optiolla (optio 3.C) siten, että todellinen ennakko vastaa 
Hestecin käyrästön ennakkoa. Jos sytytys on myöhäisellä, sitä ei voida ohjelmallisesti aikaistaa. Eli 
tällöin myöhäinen ennakko täytyy ottaa huomioon sytytysennakkokäyriä tehdessä.

Jos on lisäkortillinen Hestec jossa on dip- kytkimet, voidaan kytkimillä muuttaa perusennakkoa 
tarvittaessa myöhäisemmälle/aikaisemmalle.
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5. SÄÄTÖKARTAT

Laajempi kierrosalue säätökartastolla: (Moottoripyöräversio)

File -> settings -> program mode:

Normal –asennossa kierrosalue säätökartastolla 9000rpm = autokäyttö
Motorcycle –asennossa säätökartastolla 15000rpm = moottoripyöräkäyttö

Tämä asetus on tärkeä tarkistaa! Väärässä asennossa tiedonkeruumerkkaus/automaattisäätö ei toimi 
oikein, ja käyrästöllä käyrät näkyvät väärin.

KUN  SÄÄTÖARVOJA LÄHETETÄÄN/LUETAAN HESTECISTÄ  MOOTTORIN TÄYTYY 
OLLA SAMMUTETTUNA. (tiedonkeruu voidaan lukea moottorin käydessä).

KUN MUUTAT SÄÄTÖARVOJA, TÄYTYY NE AINA LÄHETTÄÄ OHJAINYKSIKKÖÖN 
JOTTA MUUTOKSET TULEVAT VOIMAAN (Send to ECU).

Kun ohjelman muistissa on säätöarvot (avattu tiedostosta tai luettu), voidaan säätökäyriä muuttaa 
valitsemalla Edit values ja Ignition map tai Fuel map.  

Kun uusi ikkuna avautuu, näytön oikeassa alareunassa on selitteet, jossa on kartaston kyseisen pisteen 
tiedot. Ensimmäiset 15 käyrää on 180 kierroksen välein ja loput 300 kierroksen välein. X- akselilla on 
kierroslukukäyrät, Z- akselilla kuormitus ja Y- akselilla säädettävä suure (sytytysennakko tai suuttimen
aukioloaika). 

Liikkuminen
Kartastolla voi liikkua nuolinäppäimillä. Arvoja pääsee muuttamaan  + ja – sekä pageUp ja pageDown 
näppäimillä. 

Kopiointi
Käyrän voi kopioida muistiin painamalla ctrl + C käyrän päällä. Painamalla ctrl + V halutun käyrän 
päällä, kopioituu muistissa olevat käyrä sen käyrän päälle jossa kursori on.

Yhden pisteen kopiointi samalla kierroslukukäyrällä! 
Valitse space näppäimellä arvo muistiin (valittuun pisteeseen ilmestyy keltainen kursori), ja mene 
samalla kierroslukukäyrällä toiseen kuormituspisteeseen. Paina Shift näppäintä. Muistissa oleva arvo 
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kopioituu kyseiseen kuormituspisteeseen. Siirtymällä ylemmälle tai alemmalle käyrälle, keltainen 
kursori häviää.

Automaattiset väliarvot
Tietokone voi laskea automaattisesti kierroslukukäyrällä eri kuormituksella väliarvot, jos valitaan 
kaksi pistettä . Painamalla space, tallentuu ensimmäinen arvo muistiin ja ruudulle ilmestyy merkatulle 
kohdalle vihreä kursori. Siirtymällä halutulle kuormituspisteelle ja painamalla space, tietokone laskee 
väliarvot.  Siirtymällä ylemmälle tai alemmalle käyrälle, keltainen kursori häviää.

UNDO
Kun muutetaan säätöarvoja kartastolta ja jos halutaankin palauttaa kartta aloitusarvoihinsa, valitaan 
valikosta Edit -> Undo All.

Kartaston kääntäminen
Kartastoa voi käännellä painamalla R nappia. Kartastoa voi kääntää vasemmalle  painamalla ALT ja L 
näppäimiä samanaikaisesti ja oikealle ALT ja R näppäimillä.

Usean säätöpisteen valinta kartastolla!!!
Säätökartastolla, paina shift – nappi pohjaan. Shift nappi pohjassa ja nuolinäppäimillä liikkumalla 
voidaan valita kerralla useampi säätöpiste. Pisteen muuttaminen + ja – sekä pageUp ja pageDown 
näppäimillä.
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Kuva 8. Sytytyskartta

Sytytyskartaston siirros
Sytytyskartastolla kaikkia käyriä voidaan muuttaa aikaisemmalle tai myöhäisemmälle käyttämällä 
Tuning -> Ignition movement toimintoa tai painamalla sytytyskartastolla F4. 

Klikkaamalla numeron päällä saadaan siirros aktiiviseksi. Sytytyksen siirrosta voidaan muuttaa + ja – 
näppäimillä. Painamalla OK nappia (tai enter näppäintä) sytytyskäyrät muuttuvat siirroksen verran.

Jos joku ennakkokäyrä menee alle nollan tai yli 510 , ohjelma ilmoittaa että käyriä joudutaan 
tasoittamaan.  Koska käytössä on säätöasteikko välillä 0-510
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MUISTA aina tehdä välitalletuksia kun muutat säätöarvoja (File -> Save as) Hestec ei tallenna 
automaattisesti säätöarvoja. Kun olet saanut auton säädettyä, voit poistaa välitallennukset tietokoneelta
del -näppäimellä.

HUOM!
SEOSKARTASTON SUUTTIMEN KÄYTTÖASTE  EI SAA YLITTÄÄ 93%
Jos käytetään lambda -säätöä, käyttöaste ei saa olla 85% suurempi.
Jos käyttöaste menee suuremmaksi suositellaan isompia suihkutussuuttimia tai jos mahdollista 
korkeampaa polttoaineenpainetta. 
Jos käyttöaste ylittyy kartastolla, muuttuu seliteteksti punaiseksi.

5. TIEDONKERUU

Datalog -> Open –avataan tiedostoon tallennettu tiedonkeruu. Datalog -> Read – voidaan lukea 
Hestecistä tiedonkeruu.

Tiedonkeruun näytteenottoväli – optiolla (optio 1.M) määritellään tiedonkeruuaika.  Mitä pitempi 
keruuaika, sen harvempi näytteenottoväli.  Säädön aikana käytetään yleensä asentoa 1 tai 2 (1,6 min tai
3,2 min)  Tiedonkeruu käynnistyy automaattisesti kun moottorinkierrosluku ylittää vaihtovalolle 
asetetun kierrosluvun tai vaihtoehtoisesti tiedonkeruunappia painamalla. Kun tiedonkeruuaika tulee 
täyteen, tiedonkeruu pysähtyy.

TOIJALAN AUTOSÄHKÖ S.HARINEN KY
HELMUNTIE 83,37600 VALKEAKOSKI

PUH/FAX 03-5849777

19



Kuva
9. Tiedonkeruu

Tiedonkeruussa näkyvät seuraavat mitatut suureet:
- Pakokaasun lämpö  (vaatii K tyypin anturin 0-1000 o pakosarjaan, lisävaruste)
- Imusarjan paine (vaatii anturin ohjainyksikköön)
- Lambda  (täyskuorma arvo vapaahengitteisessä yl 220-235 ja turboautoissa 235-250 
Huomioi että lambdan lämpötila vaikuttaa lukuarvoon, kylmä lambda näyttää    
laihempaa seosta = lukuarvo on pienempi )
- Kaasun asento  
- Öljyn lämpö  (vaatii anturin öljytilaan, lisävaruste)
- Moottorin lämpö
- Imuilman lämpö
- Akkujännite
- PWM lähtö  (turbopaineen säädön tai tyhjäkäynnin säädön ohjaus)
- Ennakko    (näyttää vain käyrästön ennakot, ei myöhästyksiä)
- Moottorin kierrosluku
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- Ruiskutusaika
- 4 varalla kanavaa, joihin voi liittää esimerkiksi polttoainepainepaineen tai 

pakopaineen (vaatii ohjainkortille muutoksen + paineanturin VDO 0-10 bar 
polttoainelinjaan) tai erillisiä pyörintänopeuksia

Tiedonkeruun selaaminen
Tiedonkeruuta voidaan selata vierityspalkista vetämällä, tai nuolinäppäimillä kun tiedonkeruuikkuna 
on klikattu aktiiviseksi. 
Nuolinäppäin ylös/alas siirtää tiedonkeruuta yhden ruudun verran ja vasemmalle/oikealle yhden 
näytteen verran.

Kanavien värien muuttaminen
Kanavien värejä voidaan muuttaa tiedonkeruuikkunassa tuplaklikkaamalla kanavan nimen päällä. 
Valitsemalla kanavalle täysin musta tai valkoinen väri, saadaan kanava pois näkyvistä. Vaikka 
kanavan käyrä ei näy, kanavan teksti ja lukuarvo näkyvät valkoisena. 
Valitse näkyviin ne käyrät, mitä ensisijaisesti tarvitset, esimerkiksi lambda, kaasun asento, kierrosluku.

Pisteiden merkkaus. 
Huomaa että muistissa täytyy olla säätöarvot (avattu tiedostosta tai luettu Hestecistä), muuten pisteiden
merkkaus ei toimi!!

 
manuaalisesti merkkaus
Kursori siirretään hiirellä tiedonkeruuikkunassa siihen kohtaan, missä esimerkiksi 
kiihdytys on aloitettu. Varmistetaan ettei kyseessä ole moottorijarrutustilanne eli ettei 
kaasupoljin ole ylhäällä. Painamalla shift- nappi pohjaan ja liikuttamalla hiirtä 
tiedonkeruussa halutun kohdan päällä, tallentuu muistiin kerätty kierrosluku, lambda ja 
kuormitustieto. Merkatun pisteen alapuolella näkyy punainen merkki.

automaattisesti merkkaus
valitse tiedonkeruussa file -> Search automaticly.
Tietokone merkkaa automaattisesti kiihdytys ja tasakaasutilanteet.
Moottorijarrutustilanteita ei merkata!
Tietokone tulkitsee tilanteet siten että kolmen näytteen ajan täytyy moottorinkierrosluvun
kasvaa  tai olla vakaa ja samanaikaisesti kaasunasennon olla kasvava tai vakaa. Jos 
kaasunasento tai kierroslukumittaus heittää, tietokone saattaa jättää pisteitä 
merkkaamatta. Automaattihakuun saa tarkkuutta käyttämällä pienintä näytteenottoväliä!
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Merkattujen pisteiden säätö

Sulkemalla tiedonkeruuikkuna ja menemällä seoskartastolle tai sytytyskartastolle, 
merkatut pisteet näkyvät lambda- arvon mukaisesti eri väreillä (laihat ja rikkaat kohdat). 
Ikkunan yläreunassa näkyvät värien mukaiset lambda- arvot. 

manuaalisesti merkattujen pisteiden korjaus
Merkattuja pisteitä voidaan muuttaa perinteisesti + ja – sekä pageup ja pagedown 
näppäimillä tai ohjelma voi muuttaa pisteitä automaattisesti. 

”automaattisäätö” merkatuille pisteille
Jos halutaan että tietokone muuttaa pisteitä seoskartastolla automaattisesti, valitaan 
valikosta tuning ja modify. 
Ohjelma muuttaa seosarvoja kaasunasennon ja lambda- arvon mukaisesti siten että 
tietokone hakee lambda käyrältä asetusarvon  (lisäkäyrät -> lambda curve).

HUOM! 
Automaattisäätöä käytettäessä lambda- käyrälle tarvitsee asettaa asetusarvo!!
Ehdottomasti käytettävä lämmitettävää lambdaa!!
Lambdan viestin oltava virheetöntä.

Kun muutokset halutaan voimaan, täytyy Hesteciin lähettää muutetut arvot. Jos merkatut 
pisteet halutaan pois näkyvistä, valitaan tuning ja clear marks. 
HUOM! Lambdakäyrällä asetetaan haluttu lambda-arvo kaasunasennon tai ahtopaineen 
mukaan mihin ohjelma pyrkii seosta säätämään (oletusarvo). JOS KÄYTÄT 
AUTOMAATTISÄÄTÖÄ, TARKISTA ENSIN LAMBDA KÄYRÄ LISÄKÄYRISTÄ. 
Automaattisäätö pyrkii säätämään seosta lambdakäyrän mukaiseksi!!!
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Kuva 10. Tiedonkeruusta merkatut pisteet

6. LISÄKÄYRÄT

Edit values -> extra curves – avautuu lisäkäyrät ikkuna. Lisäkäyrällä voidaan liikkua ←→ 
nuolinäppäimillä. Lisäkäyrän arvoa voidaan muuttaa ↑↓ - nuolinäppäimillä. Lisäkäyrät sisältyvät 
optioihin. Lähettämällä optiot Hesteciin, lähettää ohjelma samalla lisäkäyrät.
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Kuva 11 . Choke- käyrä

7. E- PROMMIN VAIHTO

Varmista että prommi tulee oikein päin.  Jos laitat prommin väärinpäin, älä käytä sitä enää vaan vaihda
uusi prommi ! Ole huolellinen ettet riko piirikorttia ruuvimeisselillä. Käytä kyseiseen prommiin 
sopivaa säätöohjelmaa. 

WinHestec 2004 –säätöohjelma vaatii toimiakseen vähintään v2.5W tai uudemman 
käyttöjärjestelmän. 
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Seuraavat optiot täytyy ottaa huomioon, kun vaihdat uuden prommin (jos vanha prommi on vanhempi 
kuin v2.5):
Ohjaustapa: kaasuläppäohjaus tai paineohjaus
Kierrosluvun rajoitin , joko sytytys tai ruiskutus katkaistaan
Käynnistysrikastus puolitetaan, koska uudemmassa prommissa ruiskutustapa muutettu
Käynnistys ruiskutusaika puolitetaan,koska ruiskutustapa muutettu
Optio 26 special asentoon 30 niin aktivoituuu
Sytytyksen siirto asentoon asentoon 127 = -0,0 myöhäisemmälle
Imuilman ennakkomyöhästys

8. NÄPPÄIMET

CTRL + S tarkoittaa, että painetaan samanaikaisesti CTRL ja S näppäimiä.
↨ tarkoittaa ylös tai alas nuolinäppäintä
↔ tarkoittaa oikealle tai vasemmalle nuolinäppäintä
+/- tarkoittaa + tai - näppäintä

Pääikkunassa
CTRL + S talleta säätötiedosto
CTRL + O avaa säätötiedosto
CTRL + D avaa tiedonkeruu
CTRL + E lopeta ohjelma
CTRL + I avaa sytytyskartta
CTRL + F avaa seoskartta
CTRL + H avaa optiot
CTRL + C avaa lisäkäyrät
ALT + A avaa analogianäyttö
ALT + S lähetä arvot hesteciin
ALT + R lue arvot hestecistä

Ali- ikkunoissa ESC- näppäin sulkee ikkunan.

Säätökartastolla
CTRL + C  kopioi käyrä muistiin
CTRL + V liitä käyrä muistista
CTRL + I sytytyksen siirto(sytytyskartastolta)
CTRL + A tee korjaukset automaattisesti seoskarttaan
CTRL + E sulje kartastoikkuna
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↨ vaihtaa kuormituspistettä käyrällä
↔ vaihtaa kierroslukukäyrää
+/- muuttaa säätöarvoa arvoa yhden numeroarvon
pageUP/pageDown muuttaa säätöarvoa 10 numeroarvoa
R kääntää kartastoa
ALT + R kääntää kartastoa oikealle 
ALT + L kääntää kartastoa vasemmalle

Lisäkäyrät
↨ vaihtaa käyrää
↔ vaihtaa kuormituspistettä
+/- muuttaa käyrän arvoa

Optiot
ALT + välilehden numero vaihtaa välilehteä
Option kirjain tekee option aktiiviseksi
+/- kun optio on aktiivinen, muuttaa option arvoa
F5 kaasunasennon kalibrointi (vapaahengitteinen 

kaasunasentoohjattu)

Analogianäytössä
CTRL + G graafinen mittaristo
CTRL + E sulje ikkuna

Tiedonkeruu
CTRL + P tulosta tiedonkeruussa kyseinen näyttö
CTRL + A merkkaa pisteet automaattisesti kartastolle tiedonkeruusta 
CTRL + C poista tiedonkeruusta merkatut merkit kartastolta
CTRL + E sulje tiedonkeruuikkuna
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